Working with images

Design for web content



4 common raster formats

JPEG (Joint Photographic Experts Group)
GIF (Graphics Interchange Format)
PNG-8 (Portable Network Graphics 8bit)
PNG-24 (Portable Network Graphics 24bit)
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What about WebP?

WebP is a (relatively) new image file format, promoted by Google. It promises
smaller files and good control over compression. However, despite being around
since 2010, support for the format is sketchy. Although support in Chrome and
Firefox has been good for years, Safari only implemented full support in
September 2022. Of course, older browsers like IE are not compatible.

Photoshop does have “save as” support the format but it’s not an option on the
“export” modal.

WebP is one to watch for the future, especially as sustainability gets traction in

webap



https://en.wikipedia.org/wiki/WebP

WebP browser compatibility

] Usage % of all users * I
WebP image format &-orter
Global 95.5% + 1.18% = 96.68%
Image format (based on the VP8 video format) that supports
lossy and lossless compression, as well as animation and alpha
transparency. WebP generally has better compression than
JPEG, PNG and GIF and is designed to supersede them. AVIF and
JPEG XL are designed to supersede WebP.
Usage relative  Date relative Filtered m &
uc
. Chrome fari on™ . . Browser SEEES S . .
, . for Safarion” Samsung .. Opera for Androi Firefox for QQ Baidu Kaios
Ll Edge — e Lular] 15 Android i0S Internet  OPEAMINt yiobite Android  Browser  Android  Browser  Browser  Browser
4-8 10.1

9-22 ERIRER 115
933-31 | 12-17 [P4-1586 21-18 32-137

32-117 | 18-117 |16.0-16.6] 65-117 | 19-102 6-10

119-121

17.1-TP | 119-121 17.1

Notes  Teston a real browser Known issues (1) Resources (7) Feedback

' Partial support refers to not supporting lossless, alpha and animated WebP images.
2 Partial support refers to not supporting animated WebP images.

3 safari 14.0 - 15.6 has full support of WebP, but requires macOS 11 Big Sur or later.

https://caniuse.com/webp October 2023



https://caniuse.com/webp

Colour Depth

e JPEG True Colour (24 bit)
e GIF 256 colours (8 bit)
e PNG-8 256 colours (8 bit)
e PNG-24 True Colour (24 bit)

“True” colour image formats like JPEG can display around
16 million colours (16,777,216 to be precise, that’s 256
red x 256 green x 256 blue). Since the human eye is
capable of discerning fewer colours than this, true colour
images are equivalent to what we see in the real world.

256 colour images are sometimes referred to as using an
“indexed” colour palette.

http://en.wikipedia.org/wiki/Color depth
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http://en.wikipedia.org/wiki/Color_depth

256 Colour Dithering

File formats with 256 colour palettes (GIF &
PNG-8) are not good for photographic
images.

They use a process called “dithering” to
simulate additional colours.

http://en.wikipedia.org/wiki/Dither



http://en.wikipedia.org/wiki/Dither

Killer Feature

e JPEG Variable compression

e GIF Frame animation

e PNG-8 Smaller than equivalent GIF

e PNG-24 Alpha transparency

You might wonder why we need 4 different file formats
for web design work. Well, they all have different
attributes and each one has a “killer” feature that the
others don’t and this makes them useful in different
situations.
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JPEG Compression

The JPEG file format is particularly good for
photographs because it has a “true colour”
palette and variable compression algorithm
that can be used to control file size.

Over-compression can result in “artefacts”
appearing in the image.




Image Quality vs JPEG File Size

File size

JPEG 100% = 103KB
400px JPEG 80% = 59KB

JPEG 60% = 37KB

JPEG 40% = 26KB

PNG-24 = 463KB

600px

Original image size : 2912px x 3264px reduced to 400px x 600px for use on web
Original file size: 6.12MB (612,000KB)



Quality vs Compression

100% = 463kb at 800x600px 10% = 18kb at 800x600px
low compression = high quality high compression = low quality

Image optimisation is always a balance between image quality and file size.



Transparency

e JPEG None

e GIF 1 colour

e PNG-8 1 colour

e PNG-24 Alpha channel (256 steps)

The key problem with JPEG images is the inability to
contain transparency information. Fortunately, the
more recent PNG-24 format can display 256 grades
of transparency from completely transparent to
completely opague. This information is known as an
“alpha channel”. In GIF and PNG-8 files, one of the
256 colours can be designated as transparent.
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Best used for...

e JPEG Photograp
e GIF Simple gra
e PNG-8 Simple gra

NS
ohics or animation

nhics (often smaller than GIF)

e PNG-24 Complex graphics (photo & line art)

Each format has a specific use, so make sure

you’re using the correct format for the type of ~ | Preset JPEGHiah v =

image you want to present. Using the wrong | JPEG i

format will mean using files that are too large or FMPUEW &0 =

images of poor quality. [Emgi Blur: |0 =
[¥ WEMP Matte: |E|
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Image type

Always use the correct image file format Always use the correct image file format
for the type of image you want to display for the type of image you want to display
because the fine detail of some graphic because the fine detail of some graphic
images will be lost or become “fuzzy” if images will be lost or become “fuzzy” if
the wrong file format is used. the wrong file format is used.
Essentially, use JPEG files for Essentially, use JPEG files for
photographs and PNG files for graphic photographs and PNG files for graphic
images. —— - images. .

512x512px 512x512px

PNG file used for graphic images JPEG file used inappropriately

The effect of JPEG compression is especially noticeable in the text of the right-hand image.

Note: never use images for text — this is for demonstration only.



Set your image size...

B appie.ipg @ 100% (RGB/8%) *
i 50 100 150

When working with raster images
for web, it’s a good idea to set
your Photoshop rulers to “pixels”
(Edit > Preferences > Units &
Rulers...) because that’s the most
convenient unit type for our work.

— Pixel Dimensions: §33.1K (was 431.1K)

Width: 250 pixels :l
[ @

Height: 182 |  piels -

— Document Sze: You can then resize your image
Wdee) 5.6 an (Image > Image Size...) by entering
L e L either the required width or
height value in the dialogue box.
[¥] Scale Styles L.
[¥] Constrain Proportions By default, the aspect ratio is
S e locked (small chain-link symbol),
so changing either the width or
the height will result in a
proportionally scaled image.

Resolution: 72 pixelsfinch -

Bicubic (best for smooth gradients)




Save for Web & Devices (100%)

Save for Web...

| Original | Optimized | 2-Jp | 4Up |
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Color Table

Image Size
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Photoshop has a special tool
for helping us to save our
images ready for the web. It
offers a choice of all 4
formats of interest to us and
it can give us previews of
how the image will look
once it is saved. It can also
tell us how big each file will
be and how long it will take
to download.

Curiously, Photoshop CC
now considers this to be a
“legacy” feature, but it
remains the best tool for the

job. The new Export As...
tool has similar features.

Device Central... ] [ Preview... ] [ IZI Save | [ Cancel ] [ Done

File > Export > Save for Web (Legacy)...



The web standards model

Content

Text, images, ...
Structure
HTML
Presentation
CSS

JavaScript

< viewBox="0 0 2970 1700" xmlns="http://www.w3.0rg/2000/svg" xml:space="preserve" style="fill-rule:evenodd;

clip-rule:evenodd;stroke-linecap:round;stroke-miterlimit:1.5">
<g transform="scale(1.85625 1.88889)">
< style="fill:none" d="M0 0h1600v900H0z"/>

<g transform="matrix(0.660362,-0.132369,9.94077e-18,0.613863,603.714,59.398)">
< x="153" y="122" width="461" height="611" style="fill:rgb(66,72,102);stroke:white;
stroke-width:9px;" />
</0>

<g transform="matrix(0.660362,-0.132369,3.5345e-17,0.613863,775.93,184.941)">
<>
< x="153" y="122" width="461" height="611" style="fill:rgb(110,77,234);stroke:white;

stroke-width:9px;"/>
</0>
</0>

<g transform="matrix(0.660362,-0.132369,3.5345e-17,0.613863,948.145,310.484)">
< x="153" y="122" width="461" height="611" style="fill:rgb(9,192,16);stroke:white;
stroke-width:9px;" />
</0>

<g transform="matrix(0.660362,-0.132369,3.5345e-17,0.613863,1120.36,436.027)">
< x="153" y="122" width="461" height="611" style="fill:rgb(252,166,17);stroke:white;
stroke-width:9px;" />
</g>

SVG on the Web — A Practical Guide

Scalable Vector Graphics

Unlike all the other image formats
we have talked about so far, SVG
images use vectors rather than
pixels. In other words, SVGs are
created using coordinates rather
than a matrix of coloured squares.

SVGs use the XML markup language
and can therefore be embedded
within HTML if required, unlike
raster images that must be linked.

The most obvious advantage of SVG
images is that they are infinitely
scalable and the quality does not
degrade as they get larger. Ideal for
responsive web design.


https://svgontheweb.com/

Image positioning with CSS



Mauris rhoncus, justo vitae imperdiet sodales, tellus diam ultrices est, non condimentum felis
ezt quis elit. Mascenas dolor. Nulla facilisi. Quisque velit. Nulla facilisi. Sed =ed velit. Nam
interdum.

Suspendisse congue risus et lectus. Proin pellentesque
porttitor nisl. Duis aliqguam. In eu felis. Aliqguam erat
volutpat. Aliguam scelerisque wvolutpat leo. Aenean
tempor sapien quis lorem. Nulla lorem metus, tincidunt
at, porttitor ut, vestibulum ut, nunc. Etiam ac erat non
tortor pellentesque bibendum. Ut sodales wolutpat ligula.
Maecenas westibulum suscipit sem. Nunc tristique augue
lacreet ipsum. Phasellus quis dolor. Fusce pellentesgue.
Nam mollis ullamcorper nunc. Nam viverra sodales
nunc. Prassent vulputate neque vel orci consegquat
tincidunt.

Sed elit. Nulla =apien rizus, pulvinar vel, porttitor at,
lobortis non, leo. Vivamus a odio. Sed vulputate quam a nunc. Integer aliguam. Ut ac enim
nec ligula wenenatis pretium. Cras venenatis nisl aliquet neque. Maecenas nisi. Proin faucibus

CSS Floats

CSS floats are one of the most powerful tools we
have to control the relative position of HTML
elements within a page. You're going to be using
them a lot for controlling page layouts but for
now, let's consider their use for placing images
within columns of text.

odio nibh eu enim. Nullam posuere leo a lacus. Pellentesque odio. Maecenas tempus dui at
purus tristiqgue mattis. Mauris nisi ligula, commodo non, consectetuer nec, semper in, sem.

Quisque a nisi @ mauris dignissim ultricies. Ut ipsum
purus, hendrerit ut, varius eu, fringilla sodales, magna.
Cras quis ipsum in lectus volutpat egestas. Sed eget
nibh. Morbi commaodo dapibus nunc. Pellentesque
convallis tempor erat. Ut commaodo. Aliqguam
condimentumn. Praesent lacus tortor, dapibus =it amet,
congue eget, blandit sit amet, arcu. Fusce euismod
ultricies urna. Sed bibendum lectus vel nulla. Vivamus
faucibus.

Donec mollis, ante at pretium scelerisque, pede magna
imperdiet leo, sed condimentum velit augue ac metus.
Aliguam iaculis nonummy quam. Morbi elementum

quam in lectus. Vestibulum congue, lectus sed convallis malesuada, urna lectus rhoncus tellus,
nec rutrum lectus magna a turpis. Suspendisse elementum sem a dui. Curabitur dictum mauris
sit amet urna. Cras ornare. Donec sapien purus, vehicula eget, volutpat quis, ullamcorper

By default, images will just run inline with text
(they are inline elements) but if we apply a CSS
float property rule to them, we can control where
they appear in relation to the surrounding text.

Floating an image to the right causes text to flow
to the left and vice versa.

http://alistapart.com/article/css-floats-101



http://alistapart.com/article/css-floats-101

Left Placement

odio nibh eu enim. Mullam posuere leo a lacus. Pellentezque odio. Maecenas tempus dui at
purus tristigue mattis. Mauris nisi ligula, commodo non, consectetuer nec, semper in, sem.

Quisgue a nisi @ mauris dignissim ultricies. Ut ipsum
purus, hendrert ut, varius eu, fringilla sodales, magna.
Zras quis ipsum in lectus volutpat egestas. Sed eget
nibh. Morbi commodo dapibus nunc. Pellentesque
convallis tempor erat. Ut commodo. Aliguam
condimentum. Praezent lacus tortor, dapibus =it amet,
congue eget, blandit sit amet, arcu. Fusce euismod
ultricies urna. Sed bibendum lectus vel nulla. Vivamus
faucibus.

Danec mollis, ante at pretium scelerisque, pede maana

imperdiet leo, =ed condimentum welit augue ac metus.
Aliguam iaculis nonummy gquam. Morbi elementum
guam in lectus. Vestibulum congue, lectus sed convallis malesuada, urna lectus rhoncus tellus,
nec rutrum lectus magna a turpis. Suspendisse elementum sem a dui. Curabitur dictum mauris

=it amet urna. Cras ornare. Donec sapien purus, vehicula eget, volutpat quis, ullamcorper

<img src="images/artichoke.jpg" width="200" height="200" alt="close-up of an artichoke">

img {
float: left;
margin: 7px 20px 10px 0;



Right Placement

Mauris rhoncus, justo vitae imperdiet sodales, tellus diam ultrices est, non condimentum felis
est guis elit. Maecenas dolor. Mulla facilisi. Quisgue velit. Nulla facilisi. Sed sed velit. Nam
interdum.

Suspendisse congue risus et lectus. Proin pellentesque
porttiter nisl, Duis aliguam. In eu felis. Aliguam erat
volutpat. Aliguam scelerisgue volutpat leo. Aenean

tempor sapien quis lorem. Nulla lorem metus, tincidunt
at, porttitor ut, vestibulum ut, nunc. Etiam ac erat non
tortor pellentesque bibendum. Ut sodales volutpat ligula.
Maecenas vestibulum suscipit sem. Munc tristigue augue
laoreet ipsum. Phasellus quis dolor. Fusce pellentesque.
Mam mollis ullamcorper nunc. Mam viverra sodales
nunc. Praesent vulputate neque vel orc consequat
tincidunt.

Sed elit. Nulla sapien risus, pulvinar vel, porttitor at,
lobartis non, leo. Vivamus a odio. Sed vulputate quam a nunc. Integer aliguam. Ut ac enim

nec ligula venenatis pretium. Cras venenatis nisl aliquet neque. Maecenas nisi. Proin faucibus

<img src="images/artichoke.jpg" width="200" height="200" alt="close-up of an artichoke">

img { We’'re floating the image to the right, so we are adding 20px

float: right; margin to the left side of the image to give a reasonable
, margin: 7px 0 10px 20px; separation from the text.



Centre Placement

libero odio ultrices felis, non sagittis lacus orci porta diam. Curabitur eu ipsum. Aenean nisl

quam, hendrerit non, auctor a, semper eget, sapien. Proin sit amet dolor at leo ultrices
wvestibulum.

Ut tellus nisl, egestas eget, facilisis ac, consequat ac, leo. Etiam iaculis, quam hendrerit aliquet
consequat, mauris lacus feugiat eros, =it amet =agittis felis nibh ac lectus. Proin et ercs. Nulla
erat nulla, aliguam at, rutrum et, fermentum ut, augue. Donec tempus magna id felis. Etiam

<img src="images/artichoke.jpg" width="200" height="200" alt="close-up of an artichoke">

img { Centring an image is a bit different, we can't float centre. We
display: block; need two declarations, one to change the image behaviour
) LELAS IR 2 S R0 from inline to block and another to make the left and right

margins equal using the auto value.



Circular images

libero odio ultrices felis, non sagittis lacus orci porta diam. Curabitur eu ipsum. Aenean nisl
quam, hendrerit non, auctor a, semper eget, sapien. Proin sit amet dolor at leo ultrices

vestibulum.

Ut tellus nisl, egestas eget, facilisis ac, consequat ac, leo. Etiam iaculis, quam hendrerit aliquet
consequat, mauris lacus feugiat eros, =it amet =agittis felis nibh ac lectus. Proin et ercs. Nulla
erat nulla, aliguam at, rutrum et, fermentum ut, augue. Donec tempus magna id felis. Etiam

<img src="images/artichoke.jpg" width="200" height="200" alt="close-up of an artichoke">

img { If we want to create a circular image, we must begin with a square image —
display: block; the intrinsic height and width of our image must be the same (in this case,

NEaIENEST OO it’s 200px). Then, set the border-radius to 50% (in other words, 100px).
border-radius: 50%;

} Note: Do not use the height and width attributes to force an image to be square — use an image editor to crop it.



Background Images



Background Images

Id, velit. Curabitur euismod, massa sed Ioborts raclisis, Ibero odio UItrices Telis, non sagits
lacus orci porta diam. Curabitur eu ipsum. &enean nisl guam, hendrerit non, auctor a, semper
eget, =apien. Proin =it amet dolor at leo ultrices vestibulum.

etuer adipiscing elit. Mulla in ligula in risus fermentum

i= nisl ultrices auctor. Proin arcu dui, bibendum =it amet,

lorem. Mauris enim est, vehicula eu, molestie ut, vulputate

emper, pede et lacinia accumsan, dolor lacus fermentum

i geizst. Quisgue eget odio. Curabitur molestie leo a urna. Morbi
stllorermn at augue blandit rutrum. Nulla guis lectus. Maecenas a

Proin in nisi in sem rutrum dapibus. Sed pellentesque

|ErI5I:|LIE vitae, varius vitae, fermentum ac, nulla Aliqguam

et, nisl. In justo mas=sa, aliquet ut, ullamcurper id,

Sed congue. Donec in mauris. Vestibulum wvestibulum
ELIIE-ITII:Id elit. Praesent ac risus. Mam tristigue. Sed feugiat risus vel felis. Sed libero. Praesent
nulla leo, mattis et, faucibus fermentum, venenatis =it amet, libero. Curabitur porta. Nam
congue, turpis nec condimentum facilisis, risus quam eleifend dolor, ac fermentum massa dui
in ipsum.

<p class="background">Lorem ipsum dolor.. </p>

p.background {
}

background: url(artichoke.jpg) no-repeat;

https://developer.mozilla.org/en-US/docs/Web/CSS/background

The CSS background property
can be used to display an
image in the background of
an element.

Obviously, this should be
used with caution because
background images often
make a design look too fussy
or make the overlying text
difficult to read.

In this example, an image is
shown in the background of a
paragraph element.


https://developer.mozilla.org/en-US/docs/Web/CSS/background

Background Repeat

Id, vellt. Curabitur euismod, massa sed Ioborts raclisis, Ibero odio UItrices Telis, non sagits
lacus orci porta diam. Curabitur eu ipsum. &enean nisl guam, hendrerit non, auctor a, semper

eget, =apien. Proin =it amet dolor at leo ultrices vestibulum.

L

euismod elit. Prassent ac risus. Nam tristiqué. Sed feugiat risus vel felis Sed libero. Prassent

#

nulla leo, mattis et, faucibus fermentum, venenatis =it amet, libero. Curabitur porta. Nam
congue, turpis nec condimentum facilisis, risus quam eleifend dolor, ac fermentum massa dui
in ipsum.

<p class="background">Lorem ipsum dolor.. </p>

p.background {
}

background: url(artichoke.jpg) repeat-x;

https://developer.mozilla.org/en-US/docs/Web/CSS/background-repeat

By default, all background
images will repeat both
vertically and horizontally
(the X and Y directions) but
we can control this
behaviour using the repeat
value.

In this example, the image
repeats only in the
horizontal direction (X).


https://developer.mozilla.org/en-US/docs/Web/CSS/background-repeat

Background Position

Id, welit. Curabitur edismod, massa =ed |loborts racllisis, Ibero odio UItrices relis, non sagits
lacus orci porta diam. Curabitur eu ipsum. &enean nisl guam, hendrert non, auctor a, semper
eget, sapien. Proin =it amet dolor at leo ultrices vestibulum.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nulla in ligula in risus fermentum
venenatis. Integer nec nisl venenatis nisl ultrices auctor. Proin arcu dui, bibendum =it amet,

wehicula vitae, condimentum ¥ ula eu, molestie ut, vulputate

id, ante. Morbi a turpis. Viva ! an, dolor lacus fermentum
dui, ac ullamcorper augue arcu g
arnare turpis at metus. Sed egsil ulla quis lectus. Maecenas a
purus quis diam tincidunt conva I II|:l|:ril:ru5,. Sed pellentesque
varius mauris. Ut purus neque, mentumn ac, nulla. Aliguam
erat volutpat. Maecenas vel tortg d quam. Donec elit eros,
interdum eu, placerat non, terf et ut, ullamcorper id,

i g vestibulum vestibulum

el felis. Sed libero. Frasesent

nonummy at, enim. Donec ter
euizmod elit. Pragsent ac risus.

nulla leo, mattis et, faucibus fé ' i |_ 5 0. Curabitur porta. Nam
congue, turpis nec condimentum facilisis, risus guam eleifend dolor, ac fermentum massa dui

in ipsum.

<p class="background">Lorem ipsum dolor.. </p>

p.background {

A single background image
placed in the middle of the
parent element. The position
values (50% 50%) places the
image half-way down and
half-way across the element,
effectively centring the image.
The same effect can be
created using the center
keyword. Keywords top,
bottom, left and right may
also be used.

background: url(artichoke.jpg) no-repeat 50% 50%;

}

https://developer.mozilla.org/en-US/docs/Web/CSS/background-position



https://developer.mozilla.org/en-US/docs/Web/CSS/background-position

Background Size

background-size: cover;

<p class="background">Lorem ipsum dolor.. </p>

p.background {
background-image: url(golden-gate.jpg);
background-repeat: no-repeat;
background-size: cover;

}

https://css-tricks.com/almanac/properties/b/background-size/

The background property is a
shorthand for the many
individual background
properties in CSS...

background-image
background-repeat
background-position
background-size

Each can be set independently.
The background-size property
can be used with keywords to
control how the image is
displayed. This can be useful
for responsive designs.


https://css-tricks.com/almanac/properties/b/background-size/

Background Image & Colour

Id, vellt. Curabitur euismod, massa sed |oborts raclisis, Ibero odio UItrces Telis, non sagits
lacus orci porta diam. Curabitur eu ipsum. &enean nisl guam, hendrerit non, auctor a, semper
eget, =apien. Proin =it amet dolor at leo ultrices vestibulum.

Lorem ipsumn dolor sit amet, consectetuer adipiscing elit. Nulla in ligula in risus fermentum
wvenenatis. Integer nec nisl venenatiz nisl ultrices auctor. Proin arcu dui, bibendum =it amet,

wehicula wvitag, condimentum ula eu, molestie ut, vulputate
I EELEIEE

id, ante. Morbi a turpis. Viva an, dolor lacus fermentum

dui, ac ullamcorper augue arcu 2 [F=s[u] et uraBitur molestie leo a urna. Morbi
ornare turpis at metus. Sed egaii i \ ulla quis lectus. Maecenas a
purus quis diam tincidunt conwva Ul I|:.r:ri}:ru5. Sed pellentesque
warius mauris. Ut purus neque, mentumn ac, nulla. Aliguam
erat volutpat. Maecenas vel toptg H quam. Donec elit eros,
interdum eu, placerat non, term 3 et ut, ullamcorper id,

) Augie. vestibulum vestibulum

el felis. Sed libero. Prassent

nonummy at, enim. Donec te 1
euismod elit. Prassent ac risus.
nulla leo, mattis et, faucibus fe itiz =it ar 0. Curabitur porta. Nam
congue, turpis nec condimentum facilisis, risus quam eleifend dolor, ac fermentum massa dui
in ipsum.

<p class="background">Lorem ipsum dolor.. </p>

p.background {

The background property
allows us to have both a
background image and a
background colour on the
same element (can be set
independently with the
background-color property).

CSS3 introduced the ability to
specify multiple background
images. See link for details.

background: #DOD5C6 url(artichoke.jpg) no-repeat 50% 50%;

}

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS Backgrounds and Borders/Using multiple backgrounds



https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Backgrounds_and_Borders/Using_multiple_backgrounds

Background Gradients

The Shape of Design

by Frank Chimero

The background property can also be used
to display a gradient. The options are
comprehensive, so take a look at the
documentation to find out what’s possible
and how to implement it.

Introduction Craft and Beauty Improvisation and Limitations

Introduction

What is the marker of good design? It moves. The story of a
successful piece of design begins with the movement of its
maker while it is being made, and amplifies by its publishing,
moving the work out and around. It then continues in the
feeling the work stirs in the audience when they see, use, or
contribute to the work, and intensifies as the audience passes it
on to others. Design gains value as it moves from hand to hand;
context to context; need to need. If all of this movement
harmonizes, the work gains a life of its own, and turns into a
shared experience that enhances life and inches the world
closer to its full potential.

The designer is tasked to loosely organize and arrange this movement. She is the one who works to

ensure this motion is pointed in a direction that leads us toward a desirable future. Marshall

McLuhan said that, “we look at the present through a rear-view mirror,” and we “march backwards

into the future.” Invention becomes our lens to imagine what is possible, and design is the road we M M M

follow to reach it. But, there is a snag in McLuhan's view, because marching is no way to go into the S W I t a C g ro u n I l I l a g e S u S e g ra I e n t S
future. It is too methodical and restricted. The world often subverts our best laid plans, so our road ’

calls for a way to move that is messier, bolder, more responsive. The lightness and joy afforded by

.
creating suggests that we instead dance. re S p O n S I b Iy I
0

Dancing requires music, and we each have our own song. These songs are the culmination of our
individual dispositions. It is a product of our lines of inquiry about the work that we do, and a
demonstration of the lens we use to see the world. The first portion of this book concerns itself
with these inner movements. We each carry our own tune, and if we listen to ourselves, the song
that emerges is composed of the questions that we ask while working, the methods we choose to
employ in our practice, and the bias we show by favoring certain responses over others. Each song
is the origin of the individual's creativity; it is a personal tune that compels us to make things, and
feel obligated to do so in a way specific to ourselves.

The Shape of Design: Introduction (online version)

body {

background-color: #e5edf6; /*fall-backx*/

background: linear-gradient(180deg, rgba(229,237,246,1) 0%, rgba(57,89,126,1) 100%);
}

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS Images/Using CSS gradients



https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Images/Using_CSS_gradients

Gradient Generators

- CSS Gradient by @moeamaya = === BACKGROUNDS CET) SwWATCHES BLOG RESOURCES

Upload Image ‘ @ - . .

The syntax for CSS gradients can be quite complex so, inevitably, there are lots of gradient
generator tools to help you.

https://cssgradient.io/



https://cssgradient.io/

The End.
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